There is hardly a pollution, contamination, or environmental problem that cannot be prevented or remediated through the use of filtration and separation technologies.
The American Filtration and Separations Society seeks to inform industry, academia, the general public, and the media of the importance and largely untold story of the filtration and separation industry in North America, its long-term, positive socio-environmental impact and future potential for the greater good.
Table of Contents

p6 I. Introduction to the Filtration Industry and The American Filtration and Separations Society

p10 II. Global Mega Trends and Filtration and Separation Relevance

p18 III. Filtration and Separation Technology and Environment

p32 IV. The Filtration and Separation Industry Today

p44 Appendix 1. Overview of Environmental Legislation Impacting the Filtration and Separation Industry
The future is bright for filtration and separation technology as it continues to respond to global needs and trends. Filtration is the technology that allows individuals, industries, and societies to take great leaps forward in an ever-evolving and sustainable world.
Filtration and separation technology is all around you in modern industrialized countries, and is rapidly being applied in developing countries as well. As a global business segment approaching $85 Billion in annual revenues, filtration and separation stays below the average consumer’s radar because the product that they generally purchase is not a filter. What consumers buy is a wine, beer or other beverages that has been filtered; they buy trucks and automobiles that actually contain dozens of filters; they receive injections from doctors and nurses that have been filtered; and they fly in planes whose jet fuel, hydraulic fluids and cabin air have been filtered. What filtration and separation technologies do is make the products and services that we buy or consume everyday possible, or cleaner, or safer.

Modern industries that are made possible, at least in part, by filtration and separation technology include: automotive, aerospace, chemicals, pharmaceuticals and diagnostics, medical devices, consumer electronics, food and beverage, pulp and paper, oil and gas, power generation in both public utility and battery scale processes, and environmental technologies that provide clean air, pure drinking water and wastewater treatment. The list goes on and on.

The filtration and separations industry provides the best current technology in support of a cleaner environment and in support of the EPA Charter and the regulatory decision-making process. From purifying drinkable water and breathable air, to enabling the tools and devices that define everyday living, filtration and separation technology is a resource that sustainable societies depend on.
The American Filtration and Separations Society

The American Filtration and Separations Society, headquartered in Nashville, Tenn., is a 501(c)3 educational society whose mission is to provide a forum for exchange of information among engineers, educators, scientists and technologists in all areas of the fluid/particle separations field. The Society was founded in 1987, but its roots go back farther to a professional society set up in Great Britain in the early 1960s, a time when many technical professional organizations were founded in the industrialized world.

Today, in addition to hundreds of individual members, the AFS Society has a large corporate and consultant membership that spans the filtration and separation industry, as well as component suppliers as sponsoring organizations. The Society holds semi-annual technical conferences expressly developed to advance the state of the industry and educational knowledge base through face-to-face collaboration.

AFS Conference delegates meet leaders from across the industry spectrum, including component suppliers and filter media producers, filtration system manufacturers and distributors, end-users and academics. All are part of the world’s largest Filtration Society and the principal educator of the industry.

AFS market-leading Corporate Sponsors will offer new technologies with table top displays and new booths in addition to corporate posters, at its conferences. Student and Post-Doctoral candidates offer presentations and poster sessions, highlighting the very latest, cutting edge research and technology. Delegates seeking solutions will discover advanced materials, new designs, products, suppliers and concepts. AFS technical conferences have the long-standing reputation, as the premier venue for the introduction of the newest and most innovative technologies.

AFS members fully own and run the Society filling leadership positions within twelve committees, twelve bi-annual elected board of director positions and five members of the executive committee, all of which rotate on an elected basis. The American Filtration and Separations Society is a dynamic, growing organization of dedicated professionals willing to share time, skill, and knowledge to advance the state of this critical technology.
MISSION STATEMENT

The American Filtration and Separations Society is an educational, nonprofit organization that provides a forum for networking and the exchange of technical knowledge within academia and industry in all areas of filtration and separation.
SECTION II.

Global Mega Trends Drive Filtration Demand
Global Mega Trends

A. Population Growth and Social Change

B. Disruptive Digital Technology Changes

C. Rapid Urbanization on a Global Scale

D. Climate Change and Natural Scarcity

E. Transformative Healthcare Advances

F. Recycle, Reuse and the Race to Zero Emissions/Discharge
Population growth will increase demand, which will require increased production and increases in manufacturing efficiency for industrial products, foods and beverages, transportation, and infrastructure. All of which means an increased need for filtration and separation technology.

Digital technology has been improving for decades and trends call for this to continue. As computer circuits have grown smaller and smaller while increasing in processing power, the need for filtration and separation technologies has grown and become increasingly more sophisticated.

Rapid urbanization on a global scale will require new and improved infrastructure, including water, power, communications and transportation; all of which require filtration.

Natural resource scarcity and climate change will make it increasingly difficult to supply an ever growing population with clean water. This will drive greater use of desalination technologies, and recycle and reuse of wastewater on a consumer, commercial and industrial scale, which will become the norm. Filtration and separation technology make all these processes possible.

Transformative advances in healthcare will allow people to live longer, healthier and more productive lives. A part of this process will be advances in diagnostic and drug therapies, which utilize filtration and separation technologies, and an increased focus on a cleaner environment and all natural and pure consumables, which utilize filtration and separation rather than chemical technologies to make products safe and pure.

The race to zero emissions and zero discharge for industrial manufacturing, public utilities, automotive and aerospace will be a technology challenge on many fronts. Filtration and separation are among the major enabling technologies for this purify, recycle and reuse process.

Looking to the future, these trends will drive innovation in filtration and separation technologies.
A Rapidly Changing World Demands Continuous Improvement and New Product Development.

As our population grows and urbanizes, we accelerate the need for clean energy, pure water, increased food supplies and advanced medical and improved digital devices and processing power. Utilities are strained to meet demands as are manufacturers in a host of industries. As an enabling technology to most industries, filtration and separation suppliers must continually improve existing products and develop the new products required to meet the needs for increased capacity and improved filtration performance.
**Impact on Society**

Increasing demand creates **industrial expansion and innovation**

People in greater numbers and concentration create **demand for new and expanded infrastructure**

Increasing environmental **regulation and enforcement** creates focus on cleaner processes and technologies

**Consumers choose healthy options** like natural foods and consumables, pure drinks and clean cars

---

**Impact on Filtration**

Growth in water, air and fluid processing segments **drive new media development**

Focus on water/wastewater treatment, food and beverage processing and bio-pharm/diagnostic (life science) applications

**Growth in filtration demand** across all end use markets

Continued need for **finer pore size filtration**

Increased demand for **cleanable/reusable filtration technologies** in response to recycle and reuse environment

**Long-term growth and value creation** for filtration and separation technology
The American Filtration and Separations Society and the global filtration and separation industry are actively anticipating the changes and responding to the challenges that Global Mega Trends will demand.
Impacts on Filtration and Separation Technologies

**Finer Filtration:**
Automotive engines and transmissions, turbines and compressors are built with more sophisticated machine tools requiring closer tolerances. Pharmaceuticals, and food/beverages producers are faced with increasing bacteria and virus removal challenges. Semiconductors (microelectronics) have finer minimum circuit/feature sizes that are now in the nanometer range. In the last 50 years, the filtration and separation industry has led the way with new and improved capabilities for the removal of increasingly finer particles and other chemical or ionic species.

**Filtration Media Specialization:**
Virtually every filter or filtration process/system requires a filtration medium made from any number of materials of construction including metals, plastic polymers, ceramics, natural grown substances, such as walnut shells, wood pulp rice hulls, along with mined ores and minerals. The end result being better filtration and separation media, to better serve specialized markets and increasingly diverse customer needs.

**Environmental Consciousness:**
The filtration industry has long been a disposable market and yet reusable filters, able to be cleaned in-situ or extended-life filters with greater contaminate holding capacity are rapidly growing in popularity and use. Entirely new self-cleaning capable ceramic filters are used in diesel cars and trucks on new vehicles to remove the choking soot we have all experienced in the past. Cross-flow filtration has become the new normal for water and wastewater filtration, constantly cleaning the filter surface to extend the service life of these filters by years.

**Global Manufacturing & Supply:**
Customers seek the latest filtration media, filters and filtration and separation systems wherever they can locate them as they strive to use the best available technology wherever it is found and at the lowest cost. It is quite common for filtration and separation technology suppliers to follow their customer overseas, building or buying nearby production facilities. This keeps the supply chain short, and enables Just in Time (JIT) deliveries. This trend is one of the major reasons for the ongoing consolidation of global suppliers in the filtration and separation technology segment.

**Regulation/Legislation Requiring Pollution Prevention/Control:**
Legislation and regulation have had a significant impact on increased growth within the filtration industry, with little expected change or slowdown in sight. This has driven the ongoing need for filtration and separation technology to ensure or remediate a cleaner environment. Regulatory considerations, along with improved product quality processes, demand for improved production yields, and the reduction of disposable waste are driving filtration industry growth for the foreseeable future.
SECTION III.

Filtration Technology and the Environment
The American Filtration and Separations Society believes that filtration and separation technologies can improve and transform how societies, industries and individuals handle emissions and mitigate waste.
In the last twenty-five years the concept of responsible living has taken hold, not just in the US, but around the world. Caring for the environment and making the products we consume or use cleaner, more natural and less polluting to the planet has become the norm.

**Helping Industry to "Do No Harm"**

An industrial or utility smokestack connected to a municipal incinerator with a filter capturing waste, greatly reducing the amount of garbage that must be landfilled, and at the same time generating power that keeps the lights on, is one example of filtration and separation technology working to benefit the environment.

A modern microelectronics plant embodies the latest manufacturing technology, high-paying jobs, and the prestige of being associated with advanced, 21st-century products. These plants don’t have belching smokestacks or noisy machines, but they do use toxic chemicals and exotic processes that produce both chemical and heavy metal contamination in their gas and liquid waste streams. Fortunately, these waste streams incorporate state of the art filtration and separation technology, which allow these manufacturers to reuse and recycle their waste water and plant air and purify what little is discharged.
Stewards of the Environment

A farm, large or small, was once thought to be among the most “natural” of businesses. That was before we realized that fertilizers, weed killers and insecticides in storm water run-off, pollute our rivers, lakes and streams, and ultimately our drinking water. Every day, filtration and separation companies, many of them members of The American Filtration and Separations Society, are working hand in hand with municipal water providers to filter out bacteria, cysts and fine particles, and absorb chemical contaminants before this water reaches our homes.

The American Filtration and Separations Society actively supports the concept and practice of sustainability. Our technologies support society’s effort to hand down our world to future generations intact, with the water, air and natural resources that those generations will need. In short, leave no or as little footprint behind as possible.
Clean air and water, safe foods and beverages, pure and effective drug therapies and medical devices, smaller and more powerful personal electronic devices, reliable and efficient transportation platforms such as trains, boats and planes — the member companies of the American Filtration and Separations Society have helped to make these possible.
Industry Overview

Filtration and Separation Markets

- Water/Wastewater: 42%
- Industrial Process: 23%
- HVAC/AP Control: 12%
- Transportation: 13%
- Life Sciences: 13%
Industrial workspaces containing processes like commercial printing, sawmills, and chemical and steel production, have emissions from equipment that is potentially both a health hazard to workers, and a workplace hazard for a flammable, explosive or corrosive atmosphere. Large-volume ventilation systems are a common solution. In high purity manufacturing environments, such as microelectronics or medical devices, high-efficiency, clean room filtration is employed. In microelectronics manufacturing, particulates are kept at an absolute minimum. Workers wear breathable jumpsuits made of filtration materials to keep skin flakes and other particles out of the clean room environment.

We live in urban environments and air quality must be monitored and remediated when it becomes unhealthy. Filtration and separation technologies, such as air ionizers are one of the many solutions.

Automotive applications are numerous. Depending on the vehicle, as many as one hundred different filters may be deployed. Some filters are changed frequently, such as oil filters, intake air filters and cabin air filters, while other filters may last the life of the vehicle. Critical filters are used in diesel fuel/water separators, fuel injectors, and fuel vapor recovery systems. All of these filters require different pore sizes and surface characteristics to meet the stringent specifications.

The largest filtration market segments in North America including separation and coalescing applications
Diverse Market Segments within Major Markets

Water/Wastewater

- Municipal Water/Wastewater
  Particulate • Biological • Desalination • Aeration • Solids Digestion • Odor Control

- Consumer/Commercial Water
  Point of Use and Point of Entry Filters for Hardness • Taste • Odor • Biological Purity

- Industrial Water/Wastewater
  Make-up Water and Rinse Water for Manufacturing Process • Removal of Heavy Metals and Chemical Contamination in Wastewater
Transportation

**Automotive**
Fuel • Oil • Air • Cabin Air • Sensor • Motor • Lamp Vents

**Heavy Vehicle/Off Road**
Includes Fuel • Oil • Air • Cabin Air • Sensor • Motor • Lamp Vents

**Aviation/Aerospace/Military**
Intake Air • Oil • Fuel • Cabin Air • Hydraulic
Industrial Process

- **Chemical Processing**
  Particle Filtration • Catalyst Support • Coalescing • Vents • Pollution Control

- **Oil and Gas**
  Particle Removal • Oil/Water Separations • Chemical Recycling

- **Fluid Power**
  Particle Removal • Oil/Water Separation

- **Microelectronics**
  Particulate Removal • Chemical and Rinse Water Purity • Exotic Gas Purity

- **Pulp and Paper**
  Coarse Slurry Separators • Slurry Dewatering Screens • Particulate Filters for Hydraulics and Pneumatics

- **Power Generation**
  Particulate Filters for Cooling and Processing Water • Pollution Control Filter Media for Particulates and Gases
Life Science

- **Pharmaceutical/Biotech Manufacturing**
  Particulate and Biological Filters for Product • Water Supply • Raw Materials • Vent Filters for Tanks

- **Laboratory Filters**
  Liquid and Gas Filters of Various Types for Small Scale Testing and Process Development

- **Medical Devices**
  Particle • Bacteria • Virus Removal from Fluids and Vents Filters as Needed

- **In-Vitro Diagnostics/PCR Testing**
  Particle and Biological Filters • Fluid/Capillary Transfer

- **Food and Beverage**
  Particle and Biological Filters for Visual Clarity and Biological Safety • Vent Filters for Tanks
HVAC/Pollution Control

- **Residential HVAC**
  Particle Filters • Biological and Aerosol Filters • Odor Control

- **Commercial HVAC**
  Particle and Biological Filters • Adsorption of Toxic and Corrosive Gases • Odor Control

- **Medical and Industrial Controlled Environments**
  Infection Control • Isolation and Containment of Particulates • Biologicals • Aerosols using Filters • Adsorbers • Chemicals and UV

- **Industrial Pollution and Exhaust Gas Control**
  Particulate and Toxic Gas Removal • Flue Gas Desulphurization • Carbon Sequestration • Mercury Absorption
OEM Applications

- **Consumer Electronics Vents and Filters**
  Controlled Venting and Heat Dissipation • Dust and Liquid Protection • Adsorption of Corrosive Gases

- **Industrial and Automotive Sensor Vents**
  Controlled Venting and Heat Dissipation • Dust and Liquid Protection, • Adsorption of Corrosive Gases

- **Wicking media for Air Fresheners and Writing Instruments**
  Porous Media for Controlled Rate Fluid Transfer and Release

- **Medical Device and Diagnostic Vents and Wicks**
  Sample Fluid or Reagent Transfer • Controlled Venting When Necessary
SECTION IV.

The Filtration and Separation Industry Today
As with any industry, the filtration industry has certain distinct characteristics:

**Diversified Markets**
- **RISK MITIGATION**
  Investors like filtration and separation business due to its broad variety of end-use markets.
- **BALANCED MARKET GROWTH**
  With diverse end-use markets, downturns in industry performance are rare and unlikely.
- **GLOBAL MARKETS AND SUPPLY CHAIN**
  Major filtration and separation industry players are global companies with local manufacturing and supply chains around the world.

**Growth Outpaced GDP**
- **TECHNOLOGY DRIVEN**
  New and improved technologies are readily accepted to drive both quality and efficiency.
- **REGULATORY SUPPORT**
  Prevention and mitigation of environmental concerns surrounding clean air and water supply drive new product and technology development assuring long term market growth and sustainability.
- **EXTENDED PRODUCT LIFE CYCLES**
  Product life cycles are measured in decades.

Filtration technology is a lively dynamic field where academic centers, corporate R&D labs and government research provide highly innovative developments. Virtually every manufacturing industry in North America depends on some form of filtration or separation. The AFS welcomes the challenge to explain where in the supply chain filtration has a critical role.

Filtration and separation technologies provide the promise of great opportunities for young students seeking a career path, private investment companies and governmental research entities investing in the future.
The American Filtration & Separations Society (AFS) is very proud of our accomplishments and the role our member companies play in the global marketplace. The technological accomplishments of AFS Corporate Sponsors and individual members are embedded in our everyday lives. The water we drink, the food we eat, the power that lights, warms and cools our homes and offices, the cars we drive and planes we fly are just a few of the many things that happen because a filter is doing its job.
A Global Force for Good

It can be correlated that population growth and urbanization lead to infrastructure development and the growth of industrial capacity.

Municipal governments in the US and Europe, in the late 1800s and early 1900s, propelled two important environmental and public health developments: air pollution control and water/wastewater treatment. In both instances, the concentration of people, workplaces and transportation needs led municipal governments to approach these problems as public health issues.

Looking at the rapid development of the filtration and separation industry over the last century, it is clearly a response to growing population and urbanization. These trends drive the need for a larger and safer food supply, and industrial processes that provide goods and services for a larger and wealthier population.
In just over one century, the US population has grown six-fold, and continued the radical shift to an overwhelmingly urban populace.

From the early 20th century, US industrial production began its steep rise, picking up pace during the buildup of the US military-industrial complex and continuing its strong growth building consumer goods, providing infrastructure needs for residential power and personal transportation. During this timeframe the country built strong industries in chemicals, pharmaceuticals, automobiles, foodstuffs and beverages, all of which required a strong and innovative filtration and separations industry.

US government spending has grown at a pace to match the Population and Industrial Production, and GDP. In many cases, government spending on research drives industrial growth and advances in healthcare and life sciences, both heavy users of filtration technology and porous media.
1. **US POPULATION** 225 Million, >25% rural
2. **PRODUCTION INDEX** — 50
3. **US GDP** $2.7 Trillion
4. **US EPA** — Clean Water Act in-place
5. RO Membranes Desalination of Seawater and Ozone is an alternative to chlorine
6. Injectable Drugs are membrane filtered
7. Wine and beer are highly filtered

1. **US POPULATION** 275 Million, >21% rural
2. **PRODUCTION INDEX** — 96
3. **US GDP** $9.7 Trillion
4. **US EPA** — Safe Drinking Water Act and Clean Air Act in-place
   - OSHA regulates contaminants in workplace
5. Wastewater is recycled using Ultrafiltration membranes
6. Filters are removing corrosive gases from manufacturing sites

1. **US POPULATION** 310 Million, >18% rural
2. **PRODUCTION INDEX** — 105
3. **US GDP** $16.5 Trillion
4. **EPA** Regulates power plant and automotive emissions
   - OSHA regulates oil mist and weld smoke
5. Wastewater and gas production is membrane treated for reuse or safe disposal
6. Specialty filter media are used in surgical and diagnostic devices

- **1980**
- **2000**
- **Today**
Population growth and urbanization are not isolated to the US, these are Global Trends. China and India alone will contribute one-third of the growth in urban populations, worldwide. Along with the growth in population and urbanization, many developing countries around the world are currently experiencing the rapid industrialization that occurred in the US during the previous century. They are also seeing the rapid growth of a working middle class, with its inherent demands for goods and services, including safe food and water, a reliable power grid and world-class healthcare infrastructure. All of these things provide continued global growth for the filtration and separation industry.
Urbanization and population growth in a mobile, technically advanced society create newly intensified environmental and public health issues. At the same time, advances in filtration technology help to address these issues and challenges, turning the problem from an uncontrolled situation to one that becomes a matter of routine maintenance. Virtually any physical pollution or contamination problem can be resolved or improved upon by filtration, separation or coalescing technology.
The American Chemical Society has worked with the United States Environmental Protection Agency to administer the annual Presidential Green Chemistry Challenge Awards, which recognize innovative new technologies that beneficially impact the environment, promote safety, reduce waste or make broader use of renewable materials possible.

The American Filtration and Separations Society is proud and honored to stand with our Corporate Sponsors and Individual Members, at the epicenter of change, meeting the technical challenges of a changing world.
American Filtration and Separations Society Honorees

AFS itself runs an annual, competitive awards programs. Following are product and technology winners over several years by a number of the leading industry companies in North America of the American Filtration Society Products of the Year Award:

Poroplate MaxPore → PUROLATOR FACET
Volumetric Woven Wire Mesh → GKD-USA
Harvest Clear Filtration System → PARKER HANNIFIN DOMINICK HUNTER DIV.
Biogas Filtration and Cooling System → PARKER HANNIFIN HIROSS-ZANDER DIV.
Air Filter Element → W. L. GORE & ASSOCIATES, INC.
Filter Media → CUMMINS FILTRATION, INC.
Filter System → PARKER HANNIFIN, CO.
Global Fuel Water Separation Filter Efficiency Test Stand → IFTS
TMF 61 Tube Module → POREX FILTRATION DIVISION
Parker Zander GL series compressed-air filters → PARKER HANNIFIN
Turbine Filters → W. L. GORE & ASSOCIATES
FlexBowl™ Pressure Vessel System → PALL CORPORATION
Tubular Membrane Module → POREX FILTRATION DIVISION
Torit WSO Mist Collector → DONALDSON COMPANY
Multitwister Crankcase Ventilation System → DANA CORPORATION
Filtration Crankcase Ventilation System → CUMMINS FILTRATION, INC.
Radial Cartridge Filter, Porex Corp. → POREX FILTRATION DIVISION
XLR Self-Cleaning Air Filtration System with PowerCore Media Technology for Gas Turbine Air Inlet → DONALDSON CO., INC.
Reemay Freedom Composite Pool & Spa Filter Media → BBA FIBERWEB
Matrikx Microbiological Barrier Filter → KX INDUSTRIES
PowerCore Air Intake System Severe-Duty Filter → DONALDSON CO., INC.
Ultradry centrifuge, Baker Hughes Corp. → BIRD MACHINE COMPANY
Magnum high-capacity filtration systems → PALL CORPORATION
Haynes HR-160 New Alloy Filtration Media → U.S. FILTER
History of Environmental Legislation:
From US EPA

(Excerpted directly from USEPA website)

The EPA, under the requirements of the Safe Drinking Water Act (SDWA), regulates drinking water in the United States. The EPA additionally regulates wastewater, but under the requirements of the Clean Water Act (CWA). Storm water and discharges into surface water are also regulated under the CWA.

The SDWA sets maximum contaminant levels (MCLs) and treatment techniques (TTs) that drinking water must meet to be considered safe for consumption. The list includes microorganisms, disinfectants and disinfection by-products, inorganic chemicals, organic chemicals, and radionuclides.

Safe Drinking Water Act (SDWA)
The Safe Drinking Water Act (SDWA) is the main federal law that ensures the quality of Americans’ drinking water. Under SDWA, EPA sets standards for drinking water quality and oversees the states, localities, and water suppliers who implement those standards.

SDWA was originally passed by Congress in 1974 to protect public health by regulating the nation’s public drinking water supply. The law was amended in 1986 and 1996 and requires many actions to protect drinking water and its sources: rivers, lakes, reservoirs, springs, and ground water wells. (SDWA does not regulate private wells which serve fewer than 25 individuals.)
From 1970 to 2012, aggregate national emissions of the six common pollutants alone dropped an average of 72 percent while gross domestic product grew by 219 percent. This progress reflects efforts by state, local and tribal governments; EPA; private sector companies; environmental groups and others.

The emissions reductions have led to dramatic improvements in the quality of the air that we breathe. Between 1980 and 2012, national concentrations of air pollutants improved 91 percent for lead, 83 percent for carbon monoxide, 78 percent for sulfur dioxide (1-hour), 55 percent for nitrogen dioxide (annual), and 25 percent for ozone. Fine particle concentrations (24-hour) improved 37 percent and coarse particle concentrations (24-hour) improved 27 percent between 2000, when trends data begins for fine particles, and 2012. (For more trends information, see EPA’s Air Trends site.)

These air quality improvements have enabled many areas of the country to meet national air quality standards set to protect public health and the environment. For example, all of the 41 areas that had unhealthy levels of carbon monoxide in 1991 now have levels that meet the health-based national air quality standard. A key reason is that the motor vehicle fleet is much cleaner because of Clean Air Act emissions standards for new motor vehicles.

Airborne lead pollution, a widespread health concern before EPA phased out lead in motor vehicle gasoline under Clean Air Act authority, now meets national air quality standards in most areas of the country.

State emission control measures to implement the Act, as well as EPA’s national emissions standards, have contributed to air quality improvements.
AFS MEMBER COMPANIES

A complete list of Corporate and Consultant Sponsors on the AFS can be located on the AFS website home page www.afssociety.org. Details about each company and the principal contact are available on the AFS website. Click on the company, which will lead to a summary page and contact information including their individual company website for specifics.